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I awoke this morning

Love laid me down by a river.

Drifting | turned on upstream

Bound for my forgiver.

In the giving of my eyes to see your face.
Sound did silence me

Leaving no trace.

I beg to leave, to hear your wonderous stories.
Beg to hear your wonderous stories.

He spoke of lands not far

Or lands they were in his mind.

Of fusion captured high

Where reason captured his time.

In no time at all he took me to the gate.

In haste | quickly checked the time.

If  was late | had to leave to hear your wonderous stories.
Had to hear your wonderous stories.

Hearing

Hearing

Hearing your wonderous stories.

Hearing your wonderous stories.

Itis no lie | can see deeply into the future.
Imagine everything

Youre close

And were you there to stand

So cautiously at first and then so high.

As he spoke my spirit climbed into the sky.
I bid it to return

To hear your wonderous stories.

Return to hear your wonderous stories.

Yes, November 30, 1981






"If people aren't taught the language of sound
and images, shouldn't they be considered as
lliterate as if they left college without being
able to read or write?"

George Lucas

"It sees to me that at some point, multimedia
expression is going to be like writing: it's
something you don't leave college without.
Kids are very sophisticated in navigating on
computers and surfing the Internet. | think
pretty soon they're going to have to be as
sophisticated in expressing themselves using
the media."

Dr. Mark Kann
Chair, USC Political Science Department




ok so | totally agree with stephanie
because this was an outstanding
assignment. 1 mean if you had just a
class for just digital story telling i would
SO sign up. you have a great way of
putting assignments into the criteria with
a little twist. 1 have had so much fun with
this class.

From a student in Mr. Jon Orech'’s class at Downers Grove South, posted on his
Blackboard course discussion board
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Workshop Introduction:

Everyone has stories. Stories come from a variety of places, from a person’s past, from
their family and school, and from their imagination. Digital storytelling is the process of
capturing those stories, first by writing, and then by including powerful multimedia
elements such as voice, video, imagery and music to make the story come alive.

In this session, learn how powerful multimedia elements are combined to help students
of any age group tell their story. Learn the components of effective storytelling and
how to integrate a storytelling experience into instruction. See examples of amazing
student products and learn how a digital story is created, Leave the session with a set of
resources and ideas that will help you use this powerful learning process successfully
with your students the very first time.

Goals: at the end of the two day session, participants will be able to:

1. Describe the process of digital storytelling, and a timeline for effective classroom
integration.

2. Explain the elements of a digital story, and how they contribute to the

development of voice.

Locate appropriate imagery and music for inclusion in digital stories.

Build a digital story using iMovie.

5. Describe how assessment can be used to course correct the development of a
digital story as well as evaluate the final digital story.

6. Explain how to safely and appropriately distribute digital stories on the World
Wide Web
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Tentative Agenda

Day 1 Agenda: Morning

Introducing: A New York Minute
Introductions and Workshop Goals | Why are you here?
Dissecting: A New York Minute
The Fundamentals of Digital Storytelling, with example digital stories:
e |IKEA Commercial
e Nike Squirrel
e Rachael Edwards
e True America by Amanda Dominquez
The elements of a digital story
What constitutes an effective digital story?
Understanding the process of digital storytelling

Day 1 Agenda: Afternoon

Narrative topic selection

Preparation of Narrative

Preparation of Script

Introduction to and a rationale for storyboarding

An Introduction to Creative Commons licensing
Locating Images in Flickr using FlickrStorm, or Flickr CC
Image selection

At Night: Completion of narrative | continued location of imagery

Day 2 Agenda: Morning
Introduction to iMovie

Image Searching (if necessary)
Locating music for digital stories
Build your digital story

Day 2 Agenda: Afternoon
Completion of the digital stories

Assessing the digital story

Celebration of participant digital stories

Developing a Competitive Voice: Opportunities for publishing digital stories on the
networks of the Web



Why are you here?




Would this be a valuable learning experience?
Students:

Write
Revise

Visualize

Create
Locate
Take Risks
Communicate in new ways
Collaborate
Extend
Learn new technology skills
Become more visually literate
Manage and prioritize

Use real world tools

...and produce meaningful, personal products of value




Towards a Framework for Visual Literacy Learning

David Jakes

What is your definition of visual literacy?

Visual literacy Definition: 21st Century Skills: Can students interpret, use, appreciate and create
images and video using both conventional and 21st Century media in ways that advance
thinking, decision-making, communication and learning.

Media Literacy Definition: Center for Media Literacy: The ability to access, analyze, evaluate
and create media in a variety of forms

My definition: In my opinion, visual literacy is composed of three discrete skills: navigating,
evaluating, and communicating (create and mashup) in the context of visual imagery.

There is a biological basis for visual communication.

The auditory nerve transmits sound to the brain and is composed of about 30,000 fibers.
Contrast that with the optic nerve which sends visual signals to the brain through 1 million
fibers (Burmark 2002). Basically, you’ve got a dial-up connection from the ear to the brain and
broadband from the eye to the brain. Teach kids to take advantage of the connectivity, and the
raw capacity of the brain to process visually, and then teach them that...

Emotion, depicted through visual means, sells the message.

Students must learn how to convey meaning emotionally. That’s why digital storytelling, when
done right, can be such a powerful learning experience. Anyone that has seen 4 Generations:
The Water Buffalo Movie can attest to that. View that movie...how many of you would pony up
$250 after viewing that? And take the video obituary (called the Final Word) of Art Buchwald at
the New York Times where he says “Hi, I'm Art Buchwald and | just died” and they go on to tell
his life story. Bizarre, yet powerful because of the intersection of emotion and medium. And
then teach them that...

The most powerful producer of visual imagery is the individual, its you.

Digital cameras, cell phone cameras, 100 dollar Flip Video cameras, citizen journalism, photos
of the London subway bombings, of Saddam Hussein’s execution, and 2,867,408,080 billion
photos at Flickr attest to the capability and absolute unmitigated power of the individual to
produce visual material and bring the world home. But simply producing this is not enough,
because...


http://www.metiri.com/21/Metiri-NCREL21stSkills.pdf
http://www.medialit.org/pdf/lit2105.pdf
http://www.waterbuffalomovie.com/
http://www.waterbuffalomovie.com/
http://graphics8.nytimes.com/packages/khtml/2007/01/18/obituaries/20070118_BUCHWALD_FEATURE.html

You have to share it. Understand Creative Commons. Post content online that others can use,
that enable you to connect to other users, collaborate with others, create with others and
contribute to everyone. So, teach kids to be able to do that, and in the process emphasize
that...

Individuals must be capable of working in multiple mediums to create visual messages, in
accordance with the principals of visual literacy.

They have to do something with that visual imagery and it has to be done the right way.
Create. Remix. Mashup. Post to YouTube, TeacherTube, SchoolTube, DNATube or create your
own “Tube” with StartYourTube.com . Use Google Earth to combine imagery with place. Use
the content of Google Streetview in a Web page or wiki; blend this with other media and
primary source content to create a mixed-media platform of resources that can be the raw
material of learning. Additionally, use online content creation systems like JumpCut and,
MogoPop to create messages for the distribution of content on the networks of the Web, and
to make content transportable. Why is this necessary? Because...

Visuals, when combined with other multimedia, provide individuals with a competitive voice.
One that can be heard. One that can be measured. One that says "here | am, and here's what |
think, here is what | have to contribute. Now what do you think?" Kids have meaningful things
to say, so challenge them to produce visual content with purpose and with pride. Help kids
understand that the world is more connected then ever, and that producing visual content like
this becomes even more powerful in 2008 because...

Networks for sharing and collaboration extend that voice; that voice forms the basis of
community as a contributing member of a conversation. 150,000 videos are uploaded to
YouTube per day (Wesch 2008). Between 1 and 2 million photos are uploaded to Flickr each day
(Flickr main page). Both platforms enable commenting, and YouTube encourages videos to be
produced in response to others. Complete conversations around a single photograph occur in
Flickr, an idea that is explored by Clay Shirkey in Here Comes Everybody: The Power of
Organizing With Organizations. The potential for rich dialog can occur (as well as hateful
dialog), so kids need to learn how to be a part of that, and in a positive way...

And then emphasize that in 2008:

Everyone can learn from each other, independent of time, space and place. (Ryan Bretag).

NOTE: An online version of this paper with live hyperlinks can be found at:

http://jakes.editme.com/communicatewithvisuals


http://www.creativecommons.org/
http://www.dnatube.com/
http://www.startyourtube.com/
http://earth.google.com/
http://maps.google.com/
http://www.jumpcut.com/
http://www.mogopop.com/
http://mediatedcultures.net/ksudigg/?p=163#comment-20396
http://www.shirky.com/
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Shirkey, Clay. Here Comes Everybody: The Power of Organizing Without Organizations. New
York, New York. The Penguin Group,

Wesch, Michael. "YouTube Statistics." Digital Ethonography. 18 May 2008. Kansas State
University. 7 May 2008 <http://mediatedcultures.net/ksudigg/?p=163>.




Digital Storytelling: What do kids really learn?

Digital storytelling develops visual and multimedia literacy in students. Digital
storytelling addresses the development of the interpretation of digital media and the
application of that interpretation to a personal message or story.

Digital storytelling provides students with a competitive and compelling voice by
enlarging the boundaries of who students can communicate with and by increasing the
depth and power of that communication.

Digital storytelling permits students to recapture creativity, develop it and intensify it,
apply it, extend it, and amplify it...

Digital storytelling helps students write more effectively by permitting the visualization
of the writing, resulting in an additional level of perception that extends the writing
process to a place seldom reached.

Digital storytelling provides an authentic personal learning experience- as such,
student investment is greatly increased resulting in greatly improved motivation and

end product.

Digital storytelling teaches technology and information literacy.



What makes a digital story effective or ineffective?

Effective

Ineffective




What makes up a digital story?
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Additional Elements that contribute to the digital story




The Digital Storytelling Process

Write (Narrative)

Write (Script)

Done in
Class

Storyboard

Locate Resources ﬁ

Done in
Computer
Lab

Create Q

Share




The Digital Storytelling Process: Triumph and Tragedy

Write the Narrative

v

Distill the script from the
narrative

/

Underlying theme: Triumph and
Tragedy

Storyboard and visualize the
digital story

Locate multimedia (still frame
imagery and music)

/ /

Images from Flickr.com, Google.com,
National Archives (archives.org), American
Memory (http://memory.loc.gov), Wisconsin
Historical Society (wisconsinhistory.org)

Narrate

Add multimedia .
Script

Composed in iMovie or
Photostory 3

A

By combining a visual track (multimedia)
and a auditory track (narration), a digital
story has two tracks of meaning. Deliver
factual information via voice, emotion
through imagery...

Product: Completed Digital Story




Digital Storytelling: Narrative to Script, supported by
theme

Universal Theme: loss, acceptance, success,
failure, accomplishment, etc.
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An Example of a Script

Nike Squirrel

Meet Maureen Kowalski

This is Maureen’s first time as a Eastern grey squirrel.
She likes the park, as there are plenty of trees.

She sleeps in that big oak over there.

Is she satisfied?

Yeah.

Is she happy?

No, she’s not.

You see, Maureen was a promising long distance runner in her previous
life...

And now the only time she stretches her legs is to run away from the dogs
that constantly harass her.

A cruel twist of fate brought her here, forced her to watch the runners in
the park, every day.

While pushing themselves to become better, pursuing their dreams,
tormenting her, reminding her of what she might have been...

Don’t risk it.

Reincarnate in this lifetime.



An Example of a Script

America’s Story

Welcome to a place that is always just beginning.

That rouses itself day to day, and year to year...

To admire what it’'s made, starting with nothing.

Then rushes to invent itself all over again.

Ordinary people, doing extraordinary things.

Knowing what goes on now goes on to shape tomorrow
Welcome to a land that is never exactly what you think it is...
And will never stay that way for very long.

There are a million stories in the streets of the cities that we never finish
building...

And we intend to tell them all.

20



An Example of a Script
A New York Minute

Everyone remembers where they were, at home, in a restaurant, in a car,
when they heard.

| was in a dimly lit and empty hallway in a high school.

Eight months later when | visited Ground Zero | new it would be different
than it was during the days following September 11", I didn’t really know
what to expect and | didn’t know how | would feel.

During my visit, a man near me began playing Amazing Grace on a flute.
Two hundred people gathered around him, heads bowed, all listening
intently, some eventually moved to tears...

| recorded about a minute of his performance.

Later, when | went to replay it, | realized | had lost the movie. Not only did |
lose the recording, | thought | had lost the most vivid, important experience
of my visit.

| was wrong.

Everyone lost something that day. Perhaps it was because | lost it that |
remember it most.
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Two Tracks of Meaning
David Jakes

I've just recently completed a round of digital storytelling workshops in Texas. One critical
attribute of digital storytelling that beginnners should understand is the relationship between
the personal narrative and the script. In classic digital storytelling (there are certainly other
interpretations), an author begins with a personal story (the narrative) of between 2-4 pages.
This narrative is then reduced, or distilled to its essence, to form a script of about 3/4 to 1 page,
double-spaced. The objective is then to build the story back up with the inclusion of the other
multimedia elements (still frame imagery, video). The intent of this process is to develop two
tracks of meaning, 1 auditory (the voice over of the script) and then one visual in an nature
(the images and video). This double track system is what | believe makes a digital story such a
powerful medium for communication, as both can be very emotional.

To create that emotion in the visual track, beginning digital storytellers should avoid illustrating
their story literally. Outstanding digital stories use visuals to create deep emotion, and this can
be accomplished by entering the emotion as a search term in Flickr. This is a natural for the
tagging system of Flickr and works very well. For example, if | wanted to convey an emotion of
loneliness, | would enter loneliness into the search box of the Creative Commons Attribution
pool, and then be sure to click on the Most Interesting filter, which dramatically improves the
quality of the photography. | might use this image of a sailboat (hey, it's from my photostream,
imagine that!), this picture of a chair, this bench, or this shot of windows. Because I'm in the
attribution pool, I'm sure that | can use these in my story as long as | include the Flickr screen
name in my digital story, typically in the credits at the end of the digital story.

Excellent digital stories incorporate two tracks of meaning. Be sure to work with your students
on the distillation process of narrative to script, and also strongly consider having kids convey
emotion with using specific emotional search terms in image resources like Flickr.
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http://www.flickr.com/creativecommons/by-2.0/
http://www.flickr.com/creativecommons
http://www.flickr.com/photos/jodotorg/161335960/
http://www.flickr.com/photos/latvian/136719525/
http://www.flickr.com/photos/nibito/7415264/
http://www.flickr.com/photos/lorentey/3868982/

Writing Prompts
What do you want to say to that special person?
What should you have said?
| remember when...
If I had to do it over again...
It's funny what a man/woman of my age remembers...
A story about a special sacred place....
Your firsts...
kiss, home, love, day of school
Your lasts...
lam from...

"It's just one thing..." (from City Slickers, the meaning of life) What's the one
thing?

A story that you want your grandchildren to hear
The greatest day of my life...
Themost _ day of my life
disappointing
inspiring
magical
humbling
The conflict...l thought my life would have been...but it's...

One decision (fork in the road). If | had done this...my life would have been...

MasterCard commercial...priceless
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Reflections on Narrative Writing and Digital Storytelling

Was there a time that you “discovered” new levels of meaning or a “story
within the story” in the writing process or in the construction of the digital
story; can you state what that deeper story or theme is and how you re-
worked your material and your product to convey this deeper story?

What did you learn about your own life and/or your ability to express
yourself and to communicate significant ideas through the production of
your digital story?

What were the problems you had to solve in the creation of your digital
story? That is, how did you work out the expression of ideas and feelings in
the written narrative and in the technical representation in the sight and
sounds of the digital story?

In what ways has the digital story medium enhanced not only your final
products but also sharpened your abilities as a writer; would you agree or
not that creating a digital story is a valuable writing experience?

24



Would this be a valuable learning experience for you?

You would learn to write better

You would learn to visualize your writing

You would be able to create your personal digital story
You would learn how to locate visual imagery
You could express yourself
You would learn a new way to communicate
You could collaborate
You would be challenged, pushed....

You could apply your technology skills in a completely
new way

You could renew your creativity
You could publish your product to YouTube

You could learn to use a tool you could use the rest of
your life

Would this interest you?

25



Techlearning bloqg

March 22, 2006

Digital Soft-Telling?

Digital storytelling has been receiving a tremendous amount of play recently in the
blogosphere and at conferences. You might even say it’s the next newest bandwagon. In
my district, we have had a digital storytelling program for almost three years, with some
phenomenal products being produced. During that time, we were faced, like most who
are now initiating programs, with justifying such an activity against the pressure to
perform on standardized tests.

We’ve come to grips with this by focusing on the fundamental premise that every
activity like digital storytelling is grounded in a literacy that we believe in, and that those
literacies can help students succeed in a variety of learning situations, testing included.
In this case, two very important literacies are embodied within digital storytelling:
writing and the ability to locate, interpret and use visual imagery.

Why do we do digital storytelling? | tell everyone this: it improves writing skills (it does
and we have evidence) and it makes students more visually literate. But there is more.
Something much more powerful...

So, given this interest, I've been watching the SITE conference in Orlando very closely
because they have many presentations on digital storytelling going on (see the
conference DST blog), and also because Wes Fryer is there, which means | can expect a
detailed and thoughtful blog entry about the various presentations he attends, and | can
learn something.

One comment, buried in one of his posts, caught my eye.

(Don’t worry Wes, the comments to follow are not directed at you but at whoever
expressed them-l won’t shoot the messenger.)

Here it is:
This seems so “soft” to many academics and others.

Soft? You’ve never composed a digital story, have you? Until you have, you have
absolutely no standing to make that comment. And have you seen kids do a digital
story? Have you spent an entire day taking four pages of narrative to % of a page? Do
you know the kind of writing that has to take place to get that done? Have you seen kids
use five software programs simultaneously when working on their story? Have you seen
a kid do 21 re-writes to get their script right, without being asked? And have their
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http://www.techlearning.com/blog/main/
http://site.aace.org/conf/
http://sitedigitalstory.blogspot.com/
http://www.speedofcreativity.org/2006/03/22/digital-storytelling-giving-purpose-to-pixels/
http://www.edsupport.cc/mguhlin/blog/archives/2006/03/entry_1274.htm

teacher roll-up his sleeves and provide feedback on all of those, because it’s that
important, but you know, that’s just one kid, and it looks like it’s gonna be a long night,
so make some coffee, because there are 28 more to go? Have you kicked kids out of a
packed library at 6:30 pm because they’re staying after school because the story is
about them and it has to be perfect, only to see the same kids lined up at 7 am waiting
for the library to open? Have you seen senior AP Biology kids three weeks from
graduation lose it because the project demands are that intense? Have you ever worked
with a kid who is autistic who has had to record their voice-over, and does it? Is that
soft? Or a kid that can’t find the words but is using a digital story to reconnect with
estranged siblings? Does soft describe that? How about a student with a disability that
never speaks in class by choice but records a voice-over. Soft? And have you ever sat
next to someone who is confronting a life-threatening illness, and doing so by creating a
digital story, who can barely get through the voice-over because of the emotion, and
you have to get up and walk away because you just can’t find the words to console her?

Soft?
That’s funny.

All of us must deal with standards-based education. It’s a reality. But when you don’t do
things like this, when you don’t give kids the opportunity, when you don’t harness the
power of emotion and creativity to do something great, then you truly have left children
behind. Stop talking about it, stop making excuses, and find a way. That’s what we have
always done, in spite of everything-and that’s what has always made teaching, and
teachers, great, and capable of changing a life forever....

However, you can choose your content, because teaching the internal anatomy of
flatworms is important, and getting them to know what you know is what's important. It
might be on the test. You can choose to put kids in the nice, tidy 6X5 classroom grid, and
everyone, take out your notes because what I’m covering today will be on the test! Oh,
and pass in your worksheets from last night also. You can choose your multiple choice
tests, your standards, and you can choose to find every excuse not to teach kids with
something like digital storytelling, and in the process, avoid doing something great that
potentially has a lifetime of value.

Now that's soft.
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Creating a safe environment for students

A shared network folder can be an effective portfolio of kids-safe imagery. Images were
obtained from the Flickr.com Creative Commons Attribution pool
(http://www.flickr.com/creativecommons)

& teds imagery

File Edit wiew Favorites Tools  Help Iﬂ"
B bk = [ (@) . =
d \J) L‘ﬁ; 7 Seatch \_{_7__ Folders
-~
= [ —— —
Picture Tasks ;
File and Folder Tasks
7 Make Fald
‘j Ee e 1_ball_duchcamp 2_barbwire _altemark 3_bars_c.p._storm 4_bridge_toddk 5_braken_eismcsquare 6_Comeback_kaeru
@ Publish this Folder to the:
‘wigh
& Share this Folder
» 2. <)
: =
A48
Other Places
e Removable Disk (Fi) e
[ﬂ My Pictures 7_duplication_arbron &_face sol_dust_love 9_flame_helga's 10_Flowers_alexkehr 11_fog_tinken 12_frozenrose_shiddan
& Iy Computer
\a ¥y hetwork Places
[ N i
Details 3 = -
teds imagery
File Folder 5 7
13_graveflowers_mel b 14_hand_hummanna 15_looking_c.p.storm 16_nap_kables 17_rain_r@punsell 18_rope_procsilas
Date Modified: Tuesday, June
06, 2006, 5146 PM
19_shadow_divinemis... 20_shattered_cobalt... Z1_chining_hugo 22_ctairs_hugo 23 _sunclouds_lastexit 24 _sunset_orin_boborin
ﬂ |

28



Creating a digital story with iMovie HD.

1.
2.
3.

Open iMovie. Select “Create a New Project”
Name the project and save it to a location of your choice. Click Create.
The iMovie interface loads. Note that iMovie defaults to the Clips window.

Adding Still Frame Imagery:

i

Click on the Photos icon in the Panes menu

Be sure to disable the Ken Burns effect by deselecting the “Ken Burns Effect” box.

Go to File and select Import. Locate the folder you stored your images in.

Select the images you wish to use. Multiple images can be selected in a non-sequential
manner by selecting the apple key and clicking on the images. If you wish to select a
sequential range of images, select the first image, hold the shift key down, and select the
last image.

Click open, the images will import.

All images when imported are selected, click somewhere in the window to deselect all
images.

Images can now be dragged into the timeline in accordance with the storyboard.
Images, and the amount of time they occupy, can be altered in two manners.

a. double-click on the image in the timeline and change the duration time. Click set.
b. dragthe edge of the image in the timeline.

Adding Transitions

1. Select Trans in the Panes menu. The available transitions appear.

2. Click on any transition to see its effect. The speed of the transition can be changed by using
the slider bar.

3. Dragthe transition to its proper location in the timeline-repeat as necessary.

Adding voice:

1. Click on the audio icon in the Panes window. Insert the scrubber at the location where you
wish your voice-over to start.

2. Click on the record button to start recording. Leave the mouse hovered over this button.

3. Speak into the microphone and record your voice.

4. Click the record button to stop recording. iMovie will now render your voice-over and add it

to the timeline in the appropriate track.
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Adding music:

1.

2.
3.
4

Place the scrubber at the location in the timeline where you wish the music to begin

Go to File>Import and select the location and the music file you wish to import. Click Open.
The music adds to the third track in the timeline.

The music level can be adjusted by clicking on the volume line in the track. Move up to raise
the volume and down to reduce the volume. To have this capability, be sure to enable the
“Show Clip Volume Levels” and “Show Audio Waveforms” features of the View menu.

To make your movie: Go to File>Share, select Quicktime, select Full Quality, and click Share.
The movie now renders as a Quicktime file.
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Using Flickr.com in Digital Storytelling projects

Certain photography from Flickr.com can be used in the digital storytelling process.
Flickr offers its user the ability to assign Creative Common licensing-an emerging
methodology for describing intellectual property rights. Here's how to get started:

1.  Access the Flickr Creative Commons page.

http://flickr.com/creativecommons/

2.  Four different licensing categories are available; | suggest considering Attribution
and Attribution-Non Commercial licensing. Both these categories allow students
(as well as you) to use the photography but you must include the name of the
author(s) of the photographs you use (you must supply attribution). These two
categories permit access to over 550,000 photos.

3.  Tosearch the Attribution and Attribution-Non commercial pool of photos, click on
the See More next to the number of images to access the search page for that
particular Creative Commons license.

4. Locate the photo in the search return you are interested in.

5.  Click on that photo-it will enlarge.

6. Inthe lower right corner of the Web page, locate Additional Information.

7.  Click on See Different Sizes. On the top of the page, click on the file size you are
interested in. The picture will appear at that size.

PC: Right click and Select Target As...

Mac. Control or Option key and click, Choose Download...
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http://flickr.com/creativecommons/

Using Flickr Storm for locating imagery for digital storytelling projects
David Jakes, dave@jakesonline.org
To begin, create a folder on your computer where you will store images.

1. Login to Flickr Storm at: http://www.zoo-m.com/flickr-storm/

2. Click on the advanced button and use the pull-down and select “Photos you can
use commercially (attribution):

\ Click advanced search here.

flickr
magic

:'_"I]j'\'_u-*'

Fhotos yvou can use cammercially (attribution | 2 Pyll down the menu and

Photos with a"Share Alike" license

Search Creative Commons photos... select phOtOS you can use
commercially (Attribution).

‘Photos you can use commercially (ittribution) | h
Phatos for Mon-Commercial use You may a SO use Photos for
Photos with a "Moo Derivatives" license non-commercial use.

Mon-Commercial & Mo Derivatives
Mon-Commercial & Share-Alike

Search all Photos & Licenses (defaulf)

3. Enter a single word search term in the window. In this example, we’ll enter

barns.
4. Click the Search button. The little ball starts bouncing up and down to the right

of the search button.
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5.

6.

7.

Images are returned in two windows, one upper window and a lower window.
The top window displays 40 images, the bottom window displays 80. In addition,
the lower scrollable window enables you to refine your search by selecting
suggested keywords.

A i T

Click on the thumbnail to
enlarge the photo

Cot Fi

el W
H iE 8 ! o
Bottom Window i :
Open on Flickr () by Brent and Marilynn (contact)
Addto Tray

Dowvnload

Click on any image that you are interested in and it will load into a larger preview
window. Note that the image loads into a tray on the left side of the interface.
Three options to the user are presented:

a. Open on Flickr: launches that photograph from the photographers
Flickr.com account.

b. Add to tray: selects the picture and places it into a vertical tray on the left
side of the Web page. When photos are added to the tray, the tray turns
yellow. Use the tray to collect the images that you will use in your digital
story.

c. Download: enables you to download the photograph to be stored on your
computer.

To collect images, select the Add to Tray link. You will see the image appear in
the tray on the left side of the site. Other images already in the tray will disappear
(since they were not placed there by clicking on Add to Tray) and the tray will
turn yellow.
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flickr

StBrm. | barns [E=Z3

advanced

| Images in tray. You must click on Add to
| Tray to get the images in the tray, ready for
download. When this is done properly, the

3

_;-: il .u.'!'

9. Once you have collected the images you need, you can do one of two things:
a. Search for additional images on a different topic, and add those to your
tray.
b. Download your tray

10. Downloading the Tray: Click on the download button. Doing so opens another
browser window entitled FlickrStorm-Photo Set

11. Be sure to copy the link provided into a Word document. This is a link to a

personally-created page at FlickrStorm. You can always recapture your original
search by inputting the URL (Web address).
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FlickrStorm — Photo Set

You can use your browser to save this web page and download all the photos shown below,
Simply select the “"Save as..." option from the Aile menu.

Link to this page | hitpibssae zoo-ro comiflickr-stormisetBB02d82c3feles4 367 944e8088h88abTce20624 |

(It'll be available for as long as FlickrStorm itself)

Be sure to copy this link and
save it in a Word document.

oy

This is the Flickr
username you use for
attribution.

N This launches the photo in Flickr
by ms.Tea (Creative Commons License: Attribution)
hitp : ey flickr.com/photos/S9089068@MN00/607 5952 1

i

12. Below each photograph is the original photographer’s Flickr username (you will
use this name to provide attribution to your use) and a link to the original link in
the user’s Flickr account. Click on that link.

13. The photograph launches in Flickr. Click on the All Sizes button between the
photograph name and the image itself.

14. Flickr defaults to the large size photograph. Generally, you are looking for a
photograph of around 1024X768 in size (these are pixel sizes) or vice versa.
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15. Click on the Download the large size link.
16. A File Download box appears. Click Save.

17. A Save As box appears. Be sure to change the file name, which at this point is
meaningless. Name the file with a more descriptive name, then use and
underscore and add the Flickr user’s screen name. This will enable us to record
the attribution information directly in the file name.

18. Close that window and return to the Flickr Storm Photoset page and repeat steps
12-17.

This work is licensed under the Creative Commons Attribution-Noncommercial-No
Derivative Works 3.0 United States License. To view a copy of this license, visit
http://creativecommons.org/licenses/by-nc-nd/3.0/us/ or send a letter to Creative
Commons, 171 Second Street, Suite 300, San Francisco, California, 94105, USA.
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Techlearning bloqg

August 10, 2006

Day Four! It's Pizza Time...

My final summer workshop before school starts ends tomorrow. I've been very fortunate to have
had the opportunity to work with a great number of teachers over the past year in many parts of
the country. Tomorrow will be my last day with a group of teachers from Elgin U-46 teaching them
how to create digital stories with their kids, and it’s a very important day.

We’ve been fortunate to have had four full days to explore the process of digital storytelling. The
participants have had an opportunity to build several stories with Microsoft Photostory 3 and some
have used MovieMaker 2.1, although we’ve experienced some technical issues with that platform.
Many have given it a shot, but have returned to Photostory to complete additional stories. The
digital stories are some of the best | have seen from people just learning digital storytelling. They’'ve
been building with images from the attribution pool at Flickr, which has enabled them to enhance
their stories with high quality imagery, while at the same time evaluating Flickr as a resource, as
well as learning about Creative Commons licensing.

Take a look at three of the videos to see what they have been creating. These are representative of
the high quality that all are producing:

Forward Reflections by Cindy B.
My Turn by Valerie A.
The Reflective Pool by Cindy G

They have worked extremely hard for three days, but today is the really important day-the next
step. As they get ready to leave a professional development experience, and begin to prepare for
school, I want them finish the workshop by addressing these issues:

Given what they have accomplished, what truly are the benefits of digital storytelling for
students? What will they learn?

How will the process of digital storytelling be scaled to their population?

How will the process of digital storytelling be used to provide their students with a voice, yet still
meet the demands of their district’'s roadmap and their curriculum?

How will they assess digital storytelling products, and the overall value of the process of digital
storytelling to student achievement?

How will digital storytelling be included in an overall plan to promote literacy, including visual
literacy?

Will they be willing to be leaders within their district and advocates for digital storytelling?
What will be their plan for integrating their first digital storytelling experience?

What hurdles do they have? What hurdles will their students have? How can these be addressed?
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http://www.jakesonline.org/movies/CindyB.wmv
http://www.jakesonline.org/movies/Valerie_Amen.wmv
http://www.jakesonline.org/movies/Cindy_Gemmell.wmv

We have a full and challenging day today, with finishing their remaining digital stories and
addressing the above issues. It's been my pleasure working with them and I'll see many of them
again as | am helping their district with their instructional technology support.

I'd like to thank them for their hard work-pizzas on me today. Please let Cindy, Cindy and Valerie
know how you like their stories if you have a chance.

Posted by David Jakes at 05:59 AM
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